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What is "Embedded - Microcontrollers"?

"Embedded - Microcontrollers" refer to small, integrated
circuits designed to perform specific tasks within larger
systems. These microcontrollers are essentially compact
computers on a single chip, containing a processor core,
memory, and programmable input/output peripherals.
They are called "embedded" because they are embedded
within electronic devices to control various functions,
rather than serving as standalone computers.
Microcontrollers are crucial in modern electronics,
providing the intelligence and control needed for a wide
range of applications.

Applications of "Embedded -
Microcontrollers"

Embedded microcontrollers are used in virtually every
sector of electronics, providing the necessary control and
processing power for a multitude of applications. In
consumer electronics, they manage the operations of
smartphones, home appliances, and wearable devices. In
automotive systems, microcontrollers control engine
functions, safety features, and infotainment systems.
Industrial applications rely on microcontrollers for
automation, robotics, and process control. Additionally,
microcontrollers are integral in medical devices, handling
functions such as monitoring, diagnostics, and control of
therapeutic equipment. Their versatility and
programmability make them essential components in
creating efficient, responsive, and intelligent electronic
systems.

Common Subcategories of "Embedded -
Microcontrollers"

Embedded microcontrollers can be categorized based on
their architecture, performance, and application focus.
Common subcategories include 8-bit, 16-bit, and 32-bit
microcontrollers, differentiated by their processing power
and memory capacity. 8-bit microcontrollers are typically
used in simple applications like basic control systems and
small devices. 16-bit microcontrollers offer a balance
between performance and complexity, suitable for
medium-scale applications like industrial automation. 32-
bit microcontrollers provide high performance and are
used in complex applications requiring advanced
processing, such as automotive systems and sophisticated
consumer electronics. Each subcategory serves a specific
range of applications, providing tailored solutions for
different performance and complexity needs.

Types of "Embedded - Microcontrollers"

There are various types of embedded microcontrollers,
each designed to meet specific application requirements.
General-purpose microcontrollers are versatile and used in
a wide range of applications, offering a balance of
performance, memory, and peripheral options. Special-
purpose microcontrollers are tailored for specific tasks,
such as automotive controllers, which include features like
built-in motor control peripherals and automotive-grade
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Preface
CONVENTIONS USED IN THIS GUIDE
This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS
Description Represents Examples

Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...
Initial caps A window the Output window

A dialog the Settings dialog
A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK
A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier New font:
Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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GETTING STARTED WITH PIC32

Chapter 1.  PIC32 Features
1.1 INTRODUCTION
The PIC32 is a 32-bit family of general purpose microcontrollers from Microchip 
Technology. It offers 80+ DMIPS performance with a wide variety of on-chip periph-
erals. It employs industry leading M4K MIPS32 core from MIPS Technologies, Inc. 
All members in the PIC32 family use programming interface similar to other Micro-
chip PIC® microcontrollers. In addition, PIC32 microcontrollers are pin-to-pin com-
patible with the PIC24FJ128GA family of 16-bit microcontrollers.

1.2 HIGHLIGHTS
The PIC32 family offers a number of features to enable a wide variety of applications. 
The following subsections list all the key features grouped in major categories.

Performance:
• Up to 80 MHz, MIPS M4K 32-bit core with 5 stage pipeline
• High-performance hardware multiply/divide unit – 1 multiply per clock
• Programmable user and kernel memory partition for enhanced application stability
• Multiple register sets for reduced interrupt latency
• Hardware assisted single-cycle register bits manipulations
• 128-bit wide Flash memory to shorten individual instruction fetch time
• 256 bytes of high-speed cache memory with instruction and ROM data prefetch 

buffer
• Available DMA controller with integrated CRC calculation and pattern-based 

transfer termination
• Includes USB On-The-Go controller for USB device, host, or dual-role 

applications
• USB controller has own dedicated DMA interface

Power Management:
• 2.3 to 3.6V operation
• Full-speed operation over entire voltage range
• Various low-power modes including RUN, IDLE and SLEEP
• I/O transfers via DMA in IDLE mode
• Programmable peripheral clock
• Individual peripheral ON/OFF control and operation during IDLE mode
• Multiple clock sources

Scalability:
• Industry known MIPS32-compatible M4K CPU core with 5 stage pipeline
• Large family of devices with Flash memory options from 32 KB to 512 KB
• Pin compatible with 64/100 pin PIC24FJXXXGA family of 16-bit microcontrollers 
© 2008 Microchip Technology Inc. DS61146B-page 7



Getting Started with PIC32
Ease of Use:
• PIC® microcontroller “look and feel” peripherals
• Standard MPLAB® tool-suite – MPLAB IDE, MPLAB C32 C Compiler, MPLAB 

REAL ICE™, and MPLAB ICD 2.
• Software Peripheral Libraries compatible with those for Microchip 16-bit 

microcontrollers
• Microchip developed middleware modules such as TCP/IP and 16-bit file system
DS61146B-page 8 © 2008 Microchip Technology Inc.



GETTING STARTED WITH PIC32

Chapter 2.  PIC32 Product Family
2.1 INTRODUCTION
The PIC32 family includes scalable devices ranging from 32KB to 512KB of Flash 
memory. Also a rich set of peripherals – Five timers, 16 channels of 10-bit A/D 
Converters and communication interfaces: SPI, I2C™ and UART.
Please consult the “PIC32MX Family Data Sheet” (DS61143) for a complete list of 
family variants, core and peripheral characteristics.

FIGURE 2-1: PIC32 MCU MODULES

CPUCPU

RAMRAM

128128--bitbit
FlashFlash

CC
aa
cc
hh
ee

VectoredVectored
InterruptsInterrupts

BusBus
MatrixMatrix

VREGVREG

22--WW
MCHPMCHP
DebugDebug

USBUSB
OTGOTG

SPISPI
(2)(2)

I2CI2C
(2)(2)

EUARTEUART
(2)(2)

ICIC
(5)(5)

OCOMPOCOMP
/PWM/PWM

(5)(5)

AnalogAnalog
Comp.Comp.

(2)(2)

EnhEnh..
PMPPMP

ADCADC
(16ch,(16ch,

10b)10b)

ChangeChange
NoticeNotice

(21)(21)

ODOD
/GPIO/GPIO
(85)(85)

Ext Ext INTsINTs
(5)(5)

BoundaryBoundary
ScanScan

44--WW
JTAG JTAG 
DebugDebug

55--WW
TraceTrace

DMACDMAC
++

CRCCRC

TMRTMR
(5)(5)

RTCCRTCC

WDT,WDT,
BOR.BOR.
CVRefCVRef
© 2008 Microchip Technology Inc. DS61146B-page 9



Getting Started with PIC32
NOTES:
DS61146B-page 10 © 2008 Microchip Technology Inc.



GETTING STARTED WITH PIC32

Chapter 3.  PIC32 Architecture
3.1 INTRODUCTION
The  PIC32 family of MCUs combines the MIPS M4K core together with powerful 
peripherals and embedded Flash and RAM memory to address a wide range of 
applications.

FIGURE 3-1: PIC32 BLOCK DIAGRAM
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Getting Started with PIC32
Processor core:
• MIPS M4K with 5-stage pipeline
• MIPS32-compatible Release 2 Instruction Set
• MIPS16e™ Code Compression to improve code density by up to 40%
• GPR shadow registers to minimize latency for interrupt handlers
• Bit field manipulation instructions
• High-performance Multiply/Divide Unit:

- Maximum issue rate of one 32x16 multiply per clock
- Maximum issue rate of one 32x32 multiply every other clock

• Static implementation: minimum operating frequency 0 MHz
• 2.3 to 3.6V operation with full speed over entire range
• Low-power modes including RUN, IDLE, and SLEEP

Memory:
• Unified 4GB virtual memory space
• Fixed Memory Mapping Translation (FMT) mechanism
• Flexible partitioning into kernel and user accessible memory segments for 

increased application stability

Pre Fetch Cache:
• 16 lines, each 128-bit wide, instruction Prefetch buffer
• Ability to load and lock lines – useful to create SW breakpoints in Flash and 

minimize interrupt latency

Interrupt Controller:
• Fully programmable interrupt controller with Single or Multi vector mode, support-

ing up to 95 IRQs.
• Multiple priorities and subpriorities for each vector
• Highest priority interrupt has dedicated register set for reduced interrupt latency

DMA Controller:
• Up to 4 independent channels
• Memory-to-Memory, Memory-to-Peripheral, and Peripheral-to-Memory transfers
• Programmable trigger from any IRQ
• Chainable channels, stop on match detection, Auto-Enable mode
• Data transfers can occur while the core is in IDLE mode
• Integrated programmable CRC engine: calculates on the fly while the data is 

transferred.

Enhanced Parallel Master Port:
• 8- and 16-bit data interface
• Up to 16-bit address lines, expandable using GPIO lines
• 2 Chip Select lines
DS61146B-page 12 © 2008 Microchip Technology Inc.



GETTING STARTED WITH PIC32

Chapter 4.  PIC32 Tools
4.1 INTRODUCTION
The PIC32 microcontrollers are supported by the MPLAB Integrated Development 
Environment and its full range of hardware and software tools.

4.2 HIGHLIGHTS
Items discussed in this chapter are:
• MPLAB IDE
• MPLAB C32 C Compiler
• Peripheral Libraries
• Software Solutions
• Demonstration, Development and Evaluation Boards
• Technical Documentation

4.3 MPLAB IDE
The Microchip MPLAB IDE is a FREE development toolsuite for Microsoft Windows® 
that contains:
• A single graphical interface to all debugging tools:

- Simulator
- Programmers
- Emulators
- In-Circuit Debuggers

• A full-featured editor with color-coded context
• A project manager
• Customizable data windows with in-place editable contents
• High-level source code debugging
• Extensive on-line help
The MPLAB IDE provides integrated debugging and programming facilities using any 
of the following probes connected to the target processor/Development Board:
• MPLAB ICD 2 In-Circuit Debugger: a low-cost, run-time development tool.
• MPLAB REAL ICE In-Circuit Emulator: a high speed in-circuit emulator with 

hardware and software trace capabilities. 
• FS2 JTAG probe: Developed by First Silicon Solutions, this probe uses 4-wire 

EJTAG interface to debug and program the PIC32 microcontrollers.
• MPLAB PM3 Device Programmer: a Microchip universal device programmer 

suitable for development and manufacturing purposes.
• MPLAB SIM32 Device Simulator: Accurately simulates many PIC32 peripherals 

and the CPU in selectable cycle and clock-accurate modes
© 2008 Microchip Technology Inc. DS61146B-page 15



PIC32 Tools
4.5 PERIPHERAL LIBRARIES
PIC32 MCUs integrate a large number of on-chip high-performance peripherals.
To accelerate the usage of these peripherals, the MPLAB C32 compiler for PIC32 
includes software peripheral libraries compatible with the 16-bit Microchip MCUs. The 
peripheral libraries are distributed in source and object format along with a detailed API 
description document. Software applications using MPLAB C32 compiler may call 
peripheral library functions by simply including the appropriate header file in their 
source files – the MPLAB C32 compiler has built-in knowledge of library header and 
archive files.
The peripheral include files are located in C:\Program Files\Microchip\MPLAB 
C32\pic32mx\include\peripheral and the full source code is located in 
C:\Program Files\Microchip\MPLAB C32\pic32-libs\peripheral loca-
tion in corresponding peripheral sub-directory.
The Peripheral Library contains following include files:
© 2008 Microchip Technology Inc. DS61146B-page 17
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Chapter 5.  Step-by-Step Procedures to Setup, Build, and Run a Demo Project
5.1 INTRODUCTION
In this step-by-step procedure, the basic concepts of the MPLAB Project Manager, 
Editor and Debugger will be presented. You will create a simple project and understand 
the debug capabilities of MPLAB IDE. 
No previous MPLAB IDE knowledge is assumed. For complete features set and 
comprehensive technical details of MPLAB IDE and its components, please visit our 
web site (www.microchip.com/ide).

5.2 HIGHLIGHTS
Items discussed in this chapter are:
• MPLAB IDE Setup
• Step-by-Step Guide Overview
• Selecting the Device
• Creating the Project
• Setting Up Language Tools
• Naming the Project
• Adding Files to the Project
• Attaching the Debugger
• Building the Project
• Testing the Code

5.3 MPLAB IDE SETUP

5.3.1 Install MPLAB IDE 
To install the MPLAB on your system, you could either use the supplied installation CD 
or download the latest MPLAB IDE from the Microchip web site.

- To install from a CD-ROM, just place the disk into a CD drive and follow the 
on-screen prompts (you could use Windows Explorer to find and execute the 
CD-ROM menu, menu.exe).

- If the MPLAB IDE was downloaded from the Microchip web site, unzip the file 
and execute the resulting file to install.

5.3.2 To uninstall MPLAB IDE
- Select Start>Settings>Control Panel to open the control panel.
- Double click on Add/Remove Programs. Find MPLAB IDE and select it.
- Click Change/Remove to remove the program from your system.

Note: Administrative access will be required to install the MPLAB on a PC.

Note: Administrative access might be required in order to uninstall the MPLAB.
© 2008 Microchip Technology Inc. DS61146B-page 21



Step-by-Step Procedures to Setup, Build, and Run a Demo Project
5.7 SETTING UP LANGUAGE TOOLS
Step Two of the Project Wizard sets up the language tools that are used with this 
project. Make sure the “Show all installed toolsuites” checkbox is checked. Select 
Microchip PIC32 C Compiler Toolsuite in the Active Toolsuite list box.
Then “MPLAB PIC32 Assembler (PIC32-as.exe)”,  “MPLAB PIC32 C Compiler 
(PIC32-gcc.exe)”, “MPLAB PIC32 Object Linker (PIC32-ld.exe)”, and “MPLAB PIC32 
Archiver (PIC32-ar.exe)”, should be visible in the Toolsuite Contents box. Click on each 
one to see its location. If MPLAB IDE was installed into the default directory, the paths 
for these files will be:
• for the MPLAB PIC32 assembler:
- C:\Program Files\Microchip\MPLAB IDE\ MPLAB 
C32\bin\PIC32-as.exe

• for the MPLAB PIC32 compiler:
- C:\Program Files\Microchip\MPLAB IDE\ MPLAB C32\bin\ 
PIC32-gcc.exe

• for the MPLAB PIC32 Object Linker:
- C:\Program Files\Microchip\MPLAB IDE\ MPLAB 
C32\bin\PIC32-ld.exe

• for the MPLAB PIC32 Archiver:
- C:\Program Files\Microchip\MPLAB IDE\ MPLAB 
C32\bin\PIC32-ar.exe

If these paths do not show up correctly, use the Browse button to set them to the proper 
files in the MPLAB IDE subfolders.
When you are finished, click Next>.

FIGURE 5-4: MPLAB IDE SELECT LANGUAGE TOOLSUITE
© 2008 Microchip Technology Inc. DS61146B-page 25



Step-by-Step Procedures to Setup, Build, and Run a Demo Project
5.9 ADDING FILES TO THE PROJECT
Step Four of the Project Wizard allows file selection for the project. This is where we 
can add existing files to our project. In the current example we don’t have a previously 
created file but we’ll create one once we’re done with the new project setting.
Just press Next> and the following Summary Screen will show up:

FIGURE 5-6: MPLAB IDE SUMMARY SCREEN

Press Finish and the workspace dialog shows up:

FIGURE 5-7: MPLAB IDE SAVE WORKSPACE
© 2008 Microchip Technology Inc. DS61146B-page 27



Getting Started with PIC32
Be sure to save the workspace in the Projects32 directory and name this workspace 
using the same name as for the project: MyTestProject.
Click Save.
The project space is now completely created and it should look like that:

FIGURE 5-8: MPLAB IDE PROJECT SAVE

Now we’ll create our C source file. If the MPLAB IDE Editor window is not open, click 
File->New from the top menu or the New File menu shortcut on the standard toolbar. 
The Editor window will show up.
Let’s type in a very simple Hello World program in the Editor window and save it in 
Projects32 directory as main.c. We’ll use the UART Peripheral Library provided by 
Microchip:
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Step-by-Step Procedures to Setup, Build, and Run a Demo Project
FIGURE 5-9: MPLAB IDE MAIN.C FILE

To add the newly created main.c file to our project just right click on the Source Files 
folder in the MPLAB IDE MyTestProject.mcp window and select Add File. Browse and 
select main.c file from the Projects32 directory.

The linker script that’s needed for this project is selected automatically by the MPLAB 
IDE. We don’t need to add any other file to our project.

Note: If the Project window is not open, select View->Project from the top IDE 
menu.
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Getting Started with PIC32
Right click on MyTestProject.mcp window and select Save. The test project should be 
saved. The MyTestProject.mcp should look like:

FIGURE 5-10: MPLAB IDE PROJECT SAVED

TIP: Files can be added and projects saved by using the right mouse button in the 
project window. In case of error, files can be manually deleted by selecting them and 
using the right mouse click menu.
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5.10 ATTACHING THE DEBUGGER
In order to test the code using the PIC32 Starter Kit, please refer to the PIC32MX 
Starter Kit User’s Guide (DS61144 ) for a sample project and a step-by-step getting 
started info.
For the purpose of testing our code in this document we will use an Explorer 16 
Development board (DM240001), a MPLAB REAL ICE In-Circuit Debugger 
(DV244005) and a PIC32MX360F512L PIM (MA320001) together with a 9V universal 
power supply, a serial cable and a USB cable for connecting the REAL ICE to the 
development board.

FIGURE 5-11: EXPLORER 16, MPLAB® REAL ICE™ AND 
PIC32MX360F512L PIM

Take the following steps to ensure proper connection of the REAL ICE to the Explorer 
16 development board:
1. Connect the MPLAB REAL ICE module to the PC with the USB cable.
2. Connect the MPLAB REAL ICE to the Explorer 16 Development Board with the 

short RJ-11 cable.
3. Apply power to the Explorer 16 board.
4. From the Debugger menu, click Select Tool > MPLAB REAL ICE to set the 

MPLAB REAL ICE as the debug tool in MPLAB IDE.
5. From the Debugger menu, select Connect to connect the debugger to the device. 

MPLAB IDE should report in the Output window that it found the 
PIC32MX360F512L device.

Once you have performed these steps, go to the MPLAB IDE window and from the 
Debugger->Select Tool menu select the debugging tool you’re using to connect to the 
board (i.e., MPLAB REAL ICE should be within the available choices).
Once you have selected the tool, the “Debug Toolbar” should be present just below the 
main menu bar, together with other toolbars that may be selected.

Note: MPLAB IDE may need to download new firmware if this is the first time the 
MPLAB REAL ICE is being used with a PIC32 device. Allow it to do so.

Note: Be sure to select Debug from the MPLAB IDE Build Configuration drop 
down list.
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Step-by-Step Procedures to Setup, Build, and Run a Demo Project
FIGURE 5-13: HYPER TERMINAL CONNECTION SCREEN

Click OK and, on the next screen, select the following communication settings:
• Bits Per Second: 57600
• Data Bits: 8
• Parity: None
• Stop Bits: 1
• Flow Control: None
Click OK and the Hyper Terminal session should be connected to the serial port on the 
development board.
Now return to the MPLAB IDE and double click on the line:
return nc;
in the MPLAB IDE Editor window, the main.c program, to set a breakpoint on that line, 
just after the call to strlen().
Click Debugger->Run from the main menu, or Run from the Debug toolbar. The 
program should start running and it will reach the set breakpoint. The MPLAB IDE 
window will look very similar to this one:
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Tel: 886-2-2500-6610  
Fax: 886-2-2508-0102
Thailand - Bangkok
Tel: 66-2-694-1351
Fax: 66-2-694-1350

EUROPE
Austria - Wels
Tel: 43-7242-2244-39
Fax: 43-7242-2244-393
Denmark - Copenhagen
Tel: 45-4450-2828 
Fax: 45-4485-2829
France - Paris
Tel: 33-1-69-53-63-20  
Fax: 33-1-69-30-90-79
Germany - Munich
Tel: 49-89-627-144-0 
Fax: 49-89-627-144-44
Italy - Milan 
Tel: 39-0331-742611  
Fax: 39-0331-466781
Netherlands - Drunen
Tel: 31-416-690399 
Fax: 31-416-690340
Spain - Madrid
Tel: 34-91-708-08-90
Fax: 34-91-708-08-91
UK - Wokingham
Tel: 44-118-921-5869
Fax: 44-118-921-5820

WORLDWIDE SALES AND SERVICE
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